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Section 1: Introduction

This guide contains instructions on deploying Ricoh Embedded Software Architecture (ESA) Device Client to 
multifunction devices in a LAN. It is written for systems administrators with detailed knowledge of the Omtool 
Server and the device.

This section includes:

Ricoh Embedded Software Architecture (ESA) Device Client (1-1)

Main components of the environment (1-3)

Document workflows (1-5)

Deployment summary (1-7)

Deployment summary (1-7)

Custom configuration (1-7)

Related documentation (1-8)

Ricoh Embedded Software Architecture (ESA) Device 
Client
Ricoh Embedded Software Architecture (ESA) Device Client v1.4 is compatible with AccuRoute Server v3.01 
environments. It is built against the SDK/J version 4.x and runs on supported Ricoh, Lanier, Savin, and Gestetner 2.x, 
4.x, 5.x and 7.x devices as a Java xlet called the Omtool Xlet v1.4. 

This integration brings the versatile document routing capabilities of AccuRoute to supported Ricoh, Lanier, Savin, 
and Gestetner devices. These capabilities are founded on Omtool’s Embedded Directive technology.
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In the main menu, Embedded AccuRoute for Ricoh presents the device user with several AccuRoute scanning 
features.

The display panel shows the AccuRoute scanning features.

Figure 1-1: AccuRoute scanning features on the Ricoh device running Embedded 
AccuRoute for Ricoh

Each feature has a unique function described in the following table. (For more information on how each feature works 
on the device, see Section 7: Testing. This section shows a complete screen sequence for each feature.)

Table 1-1: AccuRoute scanning features in Ricoh ESA Device Client

Feature Description
Login 
required Notes

Routing Sheet The user selects Routing Sheet. The device scans the document 
and it is distributed using the Embedded Directive that was used 
to create the AccuRoute Routing Sheet.

No

Public 
Distributions

The user selects Public Distributions and then selects a public 
distribution option, or Embedded Directive. The device scans 
the document and delivers the document to the AccuRoute 
Server via the Embedded AccuRoute for Intelligent Devices 
(Omtool ISAPI web server extension). The server decodes the 
Embedded Directive and distributes the document to the 
intended recipient.

No Public distribution options are 
associated with a special user account 
that is set up for this purpose.

Personal 
Distributions

The user selects Personal Distributions, logs in to the device, 
and selects a personal distribution option, or Embedded 
Directive. The device scans the document and delivers the 
document to the AccuRoute Server via the Embedded 
AccuRoute for Intelligent Devices (Omtool ISAPI web server 
extension). The server decodes the Embedded Directive and 
distributes the document to the intended recipient.

Yes
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Main components of the environment
The Ricoh ESA Device Client environment consists of the following components listed below. 

 AccuRoute Server - AccuRoute v3.01 

The AccuRoute Server is the main back end server for processing and routing documents. For 
instructions on installing AccuRoute Server, consult the Installation guide. 

Note AccuRoute v3.01installs the AccuRoute Intelligent Device Client v3.01 as part of the server install. No 
separate installation of this component is required.

 Ricoh Embedded Software Architecture (ESA) Device Client - This guide includes 
instructions on installing Ricoh Embedded Software Architecture (ESA) Device Client.

 Ricoh multifunction device - The following must be installed:

 SDK/J - For information, go to Supported devices (2-1).

 Omtool Xlet - This guide includes instructions on installing the Omtool Xlet on the device.

My AccuRoute The user selects My AccuRoute and logs in to the device. The 
device scans the document and it is distributed using the My 
AccuRoute preferences of the user.

Yes My AccuRoute is an advanced feature of 
AccuRoute Desktop. It enables the 
server to process all AccuRoute 
messages from the same user with the 
same Embedded Directive. For more 
information on this feature, consult the 
AccuRoute Desktop installation guide. 
Go to Related documentation on 1-8.

Scan to Folder The device scans and delivers the document to the AccuRoute 
Server. The server then processes the document and delivers it 
to the intended folder.

No

Fax The user selects Fax and enters the fax destination. The device 
scans the document and it is distributed to the specified fax 
destination.

No

Table 1-1: AccuRoute scanning features in Ricoh ESA Device Client

Feature Description
Login 
required Notes
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Installation components
The Embedded AccuRoute for Ricoh setup includes multiple components that are detailed in the following table.

Table 1-2: Description of installation components with locations and functions

Component Setup location Function

Embedded AccuRoute 
for Ricoh

Network folder where you downloaded the setup 
files. 

The setup contains the setup.exe file. Use this file to install 
Embedded AccuRoute for Ricoh. 

Omtool Xlet files …\program files\
Omtool\ISAPIClients\Ricoh\XletRepository

These files are uploaded to the Ricoh device via the 
AccuRoute Server Administrator (when the AccuRoute 
buttons are pushed to the device). 

Included are OmtoolXlet.DALP and several JAR files. The 
DALP file contains important configuration data, such as the 
network location of the web server and the file postings 
directory.

Note: Keep these files on the web server as a backup 
copy of the Omtool Xlet configuration that is running on 
the device.

Ricoh ESA Device 
Client Configuration 
file

C:\Program Files\omtool\Omtool Server\WebAPI\
OmtoolWebAPI\Scripts\Configuration.Ricoh.xml

This XML file is installed in system running the Ricoh ESA 
Device Client Device Client. 

This file supplies the configuration data to the device. It is 
configured automatically by the setup. 

Microsoft XML parser …\System\* These files are installed on the web server.

The Microsoft XML parser is used internally by Ricoh ESA 
Device Client.
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Document workflows
The workflow that moves a document from the device to its final destination involves the user, the Omtool Xlet, 
Embedded AccuRoute for Intelligent Devices (Omtool ISAPI web server extension), and the AccuRoute server. An 
understanding of this workflow can be helpful in troubleshooting an Embedded AccuRoute integration.

In its most basic workflow, the Omtool Xlet saves files to a directory on the web server, and Embedded AccuRoute 
for Intelligent Devices (Omtool ISAPI web server extension) submits the files directly to the AccuRoute server. This 
workflow applies to the features MyAccuRoute, Scan to Folder, Routing Sheet and Fax.

Important For MyAccuRoute feature, the device user must authenticate himself at the device using 
the configured authentication type. 

A- The user selects an AccuRoute scanning feature and scans a document. B - The Omtool Xlet saves the scanned document 
and copies the file to the web server. C - the web server submits the file to the AccuRoute server as a “message”. D - The 
Dispatch component applies rules to the message, and the server processes the message accordingly. 

Figure 1-2: Workflow for MyAccuRoute, Scan to Folder, Routing Sheet and Fax
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For all other scanning features, the Omtool Xlet makes requests during the scan session to authenticate users, 
retrieve Embedded Directives, and/or retrieve the user’s My AccuRoute settings. When the Omtool Xlet requires 
data from the AccuRoute server, it submits a request to Embedded AccuRoute for Intelligent Devices (Omtool ISAPI 
web server extension) which retrieves the data from the AccuRoute server and supplies it to the Omtool Xlet. As 
soon as the Omtool Xlet has the requested data, the basic workflow resumes. 

A- The user selects Personal or Public Distribution feature. (If the user chooses Personal Distribution, he logs into the device.) 
The device requests the list of Embedded Directives from the server. The AccuRoute Server returns the requested data. User 
selects an Embedded Directive from the list and scans document. B - Device delivers the document to the Ricoh ESA Device 
Client Device Client via HTTP or HTTPs protocol. C- Ricoh ESA Device Client Device Client sends the document to Embedded 
AccuRoute for Intelligent Devices (Omtool ISAPI Web Server Extension) via HTTP/HTTPs protocol which in turn routes the 
document to the AccuRoute Server. D - The Dispatch component applies rules to the message, and the server processes the 
message accordingly. 

Figure 1-3: Workflow for Public Distributions and Personal Distributions
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Deployment summary
To deploy Ricoh ESA Device Client:

1 Complete the installation requirements. (Section 2: Requirements)

2 Complete the installation. (Section 3: Installation)

3 Complete the required configurations such as adding the Ricoh device using the AccuRoute Server 
Administrator and pushing out the AccuRoute buttons to the device. (Go to Section 4: Required 
configuration.)

4 Configure the AccuRoute server. (Section 5: Required configuration on the server)

5 Configure authentication if using User PIN Authentication. 

6 Test the AccuRoute scanning features on the device. (Section 7: Testing)

7 Troubleshoot the setup if necessary. (Section 8: Troubleshooting)

Custom configuration
By default, Ricoh ESA Device Client supports one Omtool Xlet configuration. It can be modified or customized to 
support multiple configurations.

Modifying the default configuration
The default configuration is created by the Embedded AccuRoute for Ricoh setup.

To change the default configuration after Ricoh ESA Device Client has been deployed, reinstall Ricoh ESA Device 
Client:

1 Remove the Omtool Xlet from the device. 

2 Remove Ricoh ESA Device Client from the web server using Add/Remove Programs.

3 Run the Embedded AccuRoute for Ricoh setup again using the desired values. (Go to Installing Ricoh 
Embedded Software Architecture (ESA) Device Client Update on 3-2.)

4 Installing Ricoh Embedded Software Architecture (ESA) Device Client on the device. (Go to Installing 
Ricoh ESA Device Client on the device on 4-2.)
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Customizing Ricoh ESA Device Client
Ricoh ESA Device Client can be customized to:

 Run a unique configuration on each device or groups of devices.

 Use custom options for the Fax feature, such as cover pages, additional recipients, default sender 
name, default subject, delivery confirmation settings, etc.

 Override native settings on the device.

For more information, contact Omtool Sales. 

Related documentation
 AccuRoute v3.01 Server Installation Guide

 AccuRoute v4.0 Server Installation Guide

 Omtool Server Administrator Help

 Ricoh Embedded Software Architecture (ESA) Device Client Quick Start Guide

Note The quick start guide has been designed to be posted near the device, distributed to device users, and 
published on your organization’s intranet.

For all documentation related to AccuRoute v3.01, consult the AccuRoute v3.01 documentation page. 

For all documentation related to AccuRoute v4.0, consult the AccuRoute v4.0 documentation page. 

http://www.omtool.com/documentation/accuroute/4.0/documentation.htm
mailto:sales@omtool.com
mailto:sales@omtool.com
mailto:sales@omtool.com
http://www.omtool.com/documentation/accuroute/v3.01/documentation.htm
http://www.omtool.com/documentation/accuroute/v4.0/documentation.htm
http://www.omtool.com/documentation/accuroute/4.0/documentation.htm
http://www.omtool.com/documentation/accuroute/v3.01/documentation.htm
http://www.omtool.com/documentation/accuroute/v3.01/documentation.htm
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Section 2: Requirements

This section includes:

Supported devices (2-1)

Server requirements (2-4)

Installation requirements (2-4)

Deployment requirements (2-4)

Supported devices
Omtool qualified Ricoh ESA Device Client with the Ricoh Aficio 2051.

Ricoh Corporation certified the following devices with the SDK/J platform versions listed in the table below. 

The SDK/J platform, known as Embedded Software Architecture, must be installed on an SD card that remains in the 
service slot whenever the device is powered on. To check the version of the SDK/J platform installed on your Ricoh 
device, start the Application Manager. The version is displayed in the top right corner.

Note OmtoolXlet version 1.4 supports Ricoh, Lanier, Savin, and Gestetner 2.x, 4.x, 5.x and 7.x devices. It will 
also continue to support 2.x devices that were certified previously. 

Table 2-1: List of Ricoh devices and the minimum SDK/J platform versions supported by Ricoh as well 
as SDK/J platform versions included in the Ricoh ESA Device Client kit. 

Minimum SDK/J platform 
version supported

SDK/J platform version 
included in the Ricoh ESA 
Device Client kit Device Model

7.0x 7.03 • Ricoh - MP C6501, MP C7501, 
• Gestetner - MP C6501, MP C7501
• Lanier - C9065, C9075
• Savin - LD365C, LD375C

Note: The 7.0x devices have Java VM Card pre-installed. 

5.0x 5.08 • Ricoh - SP 4210, SP C820DN, SP C821DN, SP 6330N
• Gestetner - SP 4210N, C8140nD, C8150nD, SP 6330N
• Lanier - LP137N, LP540c, LP550c, LP235N
• Savin - MPL37N, CLP340D, CLP350D, MLP235n
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5.0x 5.08 • Ricoh - MP 6001 SP, MP 7001 SP, MP 8001 SP, MP 9001 SP, Pro 907EX, 
Pro 1107EX, Pro 1357EX

• Gestetner - MP 6001 SP, MP 7001 SP, MP 8001 SP, MP 9001 SP, Pro 
907EX, Pro 1107EX, Pro 1357EX

• Lanier - LD360sp, LD370sp, LD380sp, LD390sp, Pro 907EX, Pro 
1107EX, Pro 1357EX

• Savin - 9060sp, 9070sp, 9080sp. 9090sp, Pro 907EX, Pro 1107EX, Pro 
1357EX

4.1x 4.20 • Ricoh - MP C2050**, MP C2550**, MP C2800, MP C3300, MP C4000, 
MP C5000

• Gestetner - MP C2050**, MP C2550**, MP C2800, MP C3300, MP 
C4000, MP C5000

• Lanier - LD520C**, LD525C**, LD528C, LD533C, LD540C, LD550C
• Savin - C9020**, C9025**, C2828, C3333, C4040, C5050
** - Requires 512 MB memory upgrade to run solutions.

4.1x 4.20 • Ricoh - MP C2800 (E-3100)##, MP C3300 (E-3100)##, MP C4000 (E-
5100)##, 
MP C5000 (E-5100)##

• Gestetner - MP C2800 (E-3100)##, MP C3300 (E-3100)##, MP C4000 
(E-5100)##, 
MP C5000 (E-5100)##

• Lanier - LD528C (E-3100)##, LD533C (E-3100)##, LD540C (E-
5100)##, LD550C (E-5100)##

• Savin - C2828 (E-3100)##, C3333 (E-3100)##, C4040 (E-5100)##, 
C5050 (E-5100)##

## - Fiery products. 

4.1x 4.20 • Ricoh - SP C420DN
• Lanier - SP C400DN
• Savin - SP C400DN

4.1x 4.20 • Ricoh - SP 8200DN
• Gestetner - SP 8200DN
• Lanier - LP150dn
• Savin - MLP150DN

4.1x 4.20 • Ricoh - MP 2550 SP, MP 3350 SP, MP 4000 SP, MP 5000 SP, MP C6000, 
MP C7500, Pro C900S, MP 2851SP^^, MP 3351SP^^, MP 4001SP^^, MP 
5001SP^^

• Gestetner - MP 2550, MP 3350, MP 4000, MP 5000, MP C6000, MP 
C7500, Pro C900S, MP 2851SP^^, MP 3351SP^^, MP 4001SP^^, MP 
5001SP^^

• Lanier - LD425, LD433, LD040, LD050, LD260C, LD275C, Pro C900S, 
9228SP^^, 9233SP^^, 9240sp^^, 9250sp^^

• Savin - 9025, 9033, 9040, 9050, C6055, C7570, Pro C900S, 
LD528SP^^, LD533SP^^, LD140SP^^, LD150SP^^

^^ - Java VM Card Pre-installed

Table 2-1: List of Ricoh devices and the minimum SDK/J platform versions supported by Ricoh as well 
as SDK/J platform versions included in the Ricoh ESA Device Client kit. 

Minimum SDK/J platform 
version supported

SDK/J platform version 
included in the Ricoh ESA 
Device Client kit Device Model
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Omtool supports Ricoh ESA Device Client with all devices listed in the table above. 

Important It is important that you check the version of SDK/J running on your Ricoh device. As long 
as the Ricoh device is running a version of Java that was qualified, the Ricoh ESA Device 
Client will work with the Ricoh device. 

2.x 2.15 • Ricoh - 615C, SP C410DN, SP C411DN, SP 4100NL, SP 4100SF, SP 
4100SFL, SP 4100SF, SP C811DN, SP 8100DN, SP9100 DN, SP 4100N, 
SP 4110N

• Gestetner -GS106, C7526dn, C7531dn, P703nl, C7640nD, P7245, 
P7675, P71031n, P71035n

• Lanier - LD215c, LP226cn, LP231cn, LP131nL, LP131SF, LP131SFL, 
LP136SF, LP440c, LP145n, LP275hdn, LP131n, LP136n

• Savin - SGC1506, CPL27DN, CPL31DN, MLP31nL, MLP31SF, 
MLP31SFL, MLP36SF, CLP240D, MLP145, MLP175, MLP31n, MLP36n

2.x 2.15 • Ricoh - MP C2000, MP C2500, MP C3000, MP C3500, MP C4500, MP 
5500, MP 6000, MP 6500, MP 7000, MP 7500, MP 8000, MP 9000, MP 
1100, MP 1350, Pro906EX, Pro1106EX, Pro1356EX

• Gestetner - DSc525, DSc530, DSc535, DSc545, DSm755, MP 6000, 
DSm765, MP 7000, DSm775, MP 8000, DSm790, DSm7110, DSm7135, 
Pro906EX, Pro1106EX, Pro1356EX

• Lanier - LD420C, LD425C, LD430C, LD435C, LD445C, LD255, 
LD260, LD265, LD270, LD275, LD280, LD190, LD1110, LD1135, 
Pro906EX, Pro1106EX, Pro1356EX

• Savin - C2020, C2525, C3030, C3535, C4540, 8055, 8060, 8065, 8070, 
8075, 8080, 8090, 8110, 8135, Pro906EX, Pro1106EX, Pro1356EX

1.x • Ricoh - 2051, 2060, 2075, 3224C, Color 5560, 3228C, 3235C, 3245C, 
480W, 3035, 3045, 3030, MP 2510, MP 3010, MP 3500, MP 4500

• Gestetner - 
• Lanier - LD151, LD160, LD175, LD124c, LD160c, LC155, LD328c, 

LD335c, LD345c, LW411, LD235, LD245, 225, LD230, LD325, LD330, 
LD335, LD345

• Savin - 4051, 4060, 4075, C2410, C6045, SDC555, C2824, C3528, 
C4535, 4800WD, 8035, 8045, 8025, 8030, 8025e, 8030e, 8035e, 8045e

Table 2-1: List of Ricoh devices and the minimum SDK/J platform versions supported by Ricoh as well 
as SDK/J platform versions included in the Ricoh ESA Device Client kit. 

Minimum SDK/J platform 
version supported

SDK/J platform version 
included in the Ricoh ESA 
Device Client kit Device Model
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Server requirements
Ricoh ESA Device Client requires:

 AccuRoute server running AccuRoute v3.01(must be fax-enabled to support fax-based features)

 AccuRoute v3.01 Patch Roll up 1

Installation requirements
The installation requires:

 Unique e-mail address for the Public Distributions feature. (When Ricoh ESA Device Client is installed 
without the Public Distributions feature, this requirement does not apply.)

Deployment requirements
Additional requirements apply for deployment:

 Routing Sheet feature - The device users must be able to generate Routing Sheets. This requires 
access to AccuRoute Desktop v3.01 or AccuRoute Web Client (where the user can create the Routing 
Sheets).

 Public Distributions feature - The user account associated with this feature must be able to create 
Embedded Directives. This requires access AccuRoute Desktop v3.01 or AccuRoute Web Client 
(where the user can create Embedded Directives and Routing Sheets).

 Personal Distributions feature - The device user must be able to create Embedded Directives. This 
requires access to AccuRoute Desktop v3.01 or AccuRoute Web Client (where the user can create 
Embedded Directives and Routing Sheets).

 My AccuRoute feature - This requires access to AccuRoute Desktopv3.01 (where the user can 
create Embedded Directives and Routing Sheets). Additionally, My AccuRoute must be configured in 
AccuRoute Desktop and on the server.

 Scan to Folder feature - There are no special deployment requirements for this feature.

 Fax feature - There are no special deployment requirements for this feature (however the server must 
be fax enabled for this feature).
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Section 3: Installation

This section includes:

Downloading Ricoh Embedded Software Architecture (ESA) Device Client Update (3-1)

Installing Ricoh Embedded Software Architecture (ESA) Device Client Update (3-2)

Installing Ricoh ESA Device Client v1.4 (3-4)

Installing Ricoh ESA Device Client on a remote system (3-7)

Uninstalling Ricoh ESA Device Client (3-8)

Important Remove any prior version of Ricoh ESA Device Client if it is installed on the AccuRoute 
Server system using the Add/Remove Programs applet. Then remove the Omtool Xlet 
from the device following instructions in Uninstalling Ricoh ESA Device Client from a 
Ricoh device using the AccuRoute Server Administrator (4-5). 

Downloading Ricoh Embedded Software Architecture 
(ESA) Device Client Update
Ricoh ESA Device Client is available as a download for a separate fee. After you have purchased the product and 
before you can download the setup kit, contact Customer Service to obtain the special login code needed to 
download the setup kit. Customer Service will issue you the special login code after verifying that purchase is 
complete.

To download Ricoh Embedded Software Architecture (ESA) Device Client Update: 

1 Go to http://www.omtool.com/support.

2 Log in using the special code provided by Customer Service. 

3 Locate the module in the Downloads and Docs section.

4 Download the module and save it to a local drive.

5 Extract the files to a location on the system running the AccuRoute Server.

http://www.omtool.com/support
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Installing Ricoh Embedded Software Architecture (ESA) 
Device Client Update

1 Log on to the system running the AccuRoute server using an account that belongs to the 
Administrators group.

2 Navigate to the folder where you saved the module and run omARSRicoh1.4.exe

The InstallShield wizard opens the Ricoh Update page prompting you to extract and install the files.

3 Click Continue. The InstallShield wizard extracts the files and shows the Welcome message.
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4 Click Next. The End-User License Agreement page opens. 

5 Read the agreement and if you agree to the terms, check the box beside I have read and accept the 
license terms option. Click Next. The Detect Components page lists the components that will be 
updated.

6 Click Next to apply the update. When complete, you will see the Installation Completed message.

The update drops the Ricoh ESA Device Client v1.4 setup files in the directory:

C:\Program Files\omtool\Omtool Server\Clients\Ricoh
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Installing Ricoh ESA Device Client v1.4
1 Logon to the system running the AccuRoute Server using an account that belongs to the local 

Administrators group.

2 Navigate to the folder:

C:\Program Files\omtool\Omtool Server\Clients\Ricoh

3 Run setup.exe. The InstallShield wizard configures your system for installation and shows the 
Welcome message.

4 Click Next. The Embedded AccuRoute for Ricoh Configuration page opens. 

5 In the AccuRoute text box, enter the AccuRoute Server name or the IP Address. 

6 In the Authentication text box, enter the Active Directory server name or its IP Address. 

7 In the Default domain text box, enter domain to which the system belongs.

8 In the Authentication Type section, select the method by which device users should authenticate 
themselves. The device displays a login page depends on the type of authentication you select. 

 If you choose Non-Authenticated Email, the device displays an email textbox. To login, enter 
a valid email address that was created in Active Directory.

 If you choose PIN, the device displays a PIN text box to login to use AccuRoute features. 

Note PIN refers to an attribute of the Active Directory and it can be changed to point to any other Active 
Directory field by modifying the Configuration.Ricoh.xml file. 
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 If you choose PIN with Password, the device displays the PIN and the Password text boxes. 
Device users have to enter a PIN and the corresponding password as defined in Active Directory. 

 If you choose Login with Password, the device displays text boxes for a username and 
password as defined in the Active Directory. 

9 In the Filing Protocol section, select from HTTP (the default) or HTTPs.

10 Click Next. The Product Options page opens.

All the product options are selected by default. 

11 If you do not want to install any option, un-check the check box beside that option. 

If you select the Public Distributions option, you must specify an email address. All Embedded 
Directives for this user are listed under Public Distribution options. If you do not specify the email 
address, InstallShield Wizard will not let you proceed with the installation. 

12 In the Email text box, enter the email address that is related to Public Distributions. 
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13 Click Next. The Ready to Install the Program page opens. 

14 Click Install to begin installation. The setup installs Ricoh Embedded Software Architecture (ESA) 
Device Client. 

When installation is complete, the InstallShield Wizard shows a message indicating that the installation 
is complete. 

15 Click Finish to close the wizard. 

16 Continue to Section 4: Required configuration. 
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Installing Ricoh ESA Device Client on a remote system
1 Logon to the system where you want to install Ricoh ESA Device Client using an account that belongs 

to the local Administrators group.

Note The system must be running Windows 2008, 2003 64 bit and must have Embedded AccuRoute for 
Intelligent Devices (Omtool ISAPI Web Server Extension) installed. 

2 Navigate to the folder:

C:\Program Files\omtool\Omtool Server\Clients\Ricoh

3 Run setup.exe. 

The InstallShield wizard configures your system for installation and shows the Welcome message.

4 Follow the instructions in Installing Ricoh ESA Device Client v1.4 (3-4) to complete the remote 
installation. 
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Required DCOM permissions on the AccuRoute Server
When you install Ricoh ESA Device Client on a remote system, you must configure the following DCOM permissions 
on the AccuRoute Server. Without this configuration, the AccuRoute Server cannot communicate with the remote 
clients. To configure DCOM permissions:

1 Logon to the AccuRoute Server using an account that belongs to the local Administrators group.

1 Click Start > Run.

2 Enter dcomcnfg. Press OK. The Component Services console opens. 

3 Expand Component Services > Computers > MyComputer.

4 Select Properties to open the My Computer Properties page.

5 Click COM Security.

6 Under Access Permissions, click Edit Default.

7 Add Anonymous_Logon to the list of users and give him full permissions.

8 Click OK twice to close open dialogs.

9 In the left pane, expand DCOM Config. 

10 Browse down to find the application OmGFAPIServer.

11 Right click the application and select Properties from the drop down menu. The Properties page 
opens. 

12 Click Security to open the Security page. 

13 For all three levels Launch and activation permissions, Access Permissions and 
Configuration Permissions, click Edit.

14 Add Anonymous_Logon to the list of users and give him full permissions. 

15 Click OK, and then OK again to close all open dialogs. 

Uninstalling Ricoh ESA Device Client
1 Go to the Control Panel and start Add or Remove Programs.

2 Select Embedded AccuRoute for Ricoh and click Remove.

You are prompted to confirm that you want to uninstall the software.

3 Click Yes. 

Ricoh ESA Device Client is uninstalled from your system. A progress indicator shows the status of the 
uninstallation. 
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Section 4: Required configuration

This section includes:

Configuring IIS to run 32-bit applications (4-1)

Modifying the DeviceLoader.xml (4-1)

Installing Ricoh ESA Device Client on the device (4-2)

Configuring IIS to run 32-bit applications
1 Open a command prompt, and enter:

cscript.exe C:\InetPub\adminscripts\adsutil.vbs set W3SVC/AppPools/

Enable32bitAppOnWin64 1

2 Press Enter.

For information on related command to switch modes, see http://support.microsoft.com/kb/894435.

Modifying the DeviceLoader.xml
All Ricoh devices where you will install the Ricoh ESA Device Client must be added to the Deviceloader.xml manually 
prior to query or installation of the client application.

Important If you have multiple devices that are the same model, for example, you have three Aficio 
MP 3000 devices in your environment, you will need to add the model number only once 
in the Deviceloader.xml file. 

Before you add any device model number, check the Deviceloader.xml to see if the model number information was 
from before. In that case, you will not need to add the information. 

To modify the DeviceLoader.xml:

1 Go to the directory:

C:\Program Files (x86)\omtool\ISAPIClients\Ricoh

2 Open Deviceloader.xml file for editing purpose.

http://support.microsoft.com/kb/894435
http://support.microsoft.com/kb/894435
http://support.microsoft.com/kb/894435
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3 Under the Model node add the appropriate information for Ricohmodel and GroupnumberX into 
a new Model type as follows:

<Model type="Ricohmodel"minimumFirmware="">GroupnumberX</Model>

For example:

For a list of supported devices, see the Supported devices (2-1) section. 

4 Save your changes and close the file. 

Installing Ricoh ESA Device Client on the device
There are two steps to this process:

 Adding the Ricoh MFP to the list under the Devices node in the AccuRoute Server Administrator

 Pushing out the AccuRoute buttons to the Ricoh MFP using the AccuRoute Server Administrator

Adding a Ricoh device using the AccuRoute Server Administrator
1 Click Start > All Programs > Omtool > AccuRoute Server > AccuRoute Server 

Administrator.

2 In the console tree, expand the AccuRoute Server Administrator.

3 Go to the Devices node.

4 Click Default > New > Ricoh device.
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The Properties for the device page opens. 

5 In the Name text box, enter a name for the device. 

6 Optionally, in the Description text box, enter a description of the device.

7 In the Network Address text box, enter the IP address of the Ricoh device.

8 Verify the Group is listed as Default. 
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9 Click the Device Configuration tab.

10 In the Device Admin Password text box, enter the device administrator password. If no password 
is set for the administrator, leave it empty. 

Note In the Source Path text box, the physical path to the location where Ricoh ESA Device Client is installed 
is listed. 

11 Click OK to add the device.

A query is sent to locate the device. Once the device has been located, the device is added. Its status 
is shown as Query - Succeeded.

Pushing Ricoh ESA Device Client to the Ricoh device using the 
AccuRoute Server Administrator
When you install Ricoh ESA Device Client on the device, it pushes the AccuRoute buttons on the device for use. To 
install Ricoh ESA Device Client to the Ricoh device: 

1 Click Start > All Programs > Omtool > AccuRoute Server > AccuRoute Server 
Administrator.

2 In the console tree, expand the AccuRoute Server Administrator.

3 Go to the Devices node.
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4 In the details pane, select the device on which you want to install Ricoh ESA Device Client.

5 Right click and select Install from the drop down options. 

The AccuRoute buttons and configurations are now pushed out to the device. When installation is 
complete, walk up to the device and verify that the AccuRoute buttons are visible on the screen.

Uninstalling Ricoh ESA Device Client from a Ricoh device using the 
AccuRoute Server Administrator

1 Click Start > All Programs > Omtool > AccuRoute Server > AccuRoute Server 
Administrator.

2 In the console tree, expand the AccuRoute Server Administrator.

3 Go to the Devices node.

4 In the details pane, select the device from which you want to uninstall. 

5 Right click and select Uninstall from the drop down options. The AccuRoute buttons are uninstalled 
from the device.

Rebooting a Ricoh device using the AccuRoute Server Administrator
1 Click Start > All Programs > Omtool > AccuRoute Server > AccuRoute Server 

Administrator.

2 In the console tree, expand the AccuRoute Server Administrator.

3 Go to the Devices node.

4 In the details pane, select the device you want to reboot. 

5 Right click and select Reboot from the drop down options. 
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Section 5: Required configuration on the 
server

This section includes:

Creating a rule for Scan to Folder feature (5-1)

When a message arrives on the AccuRoute server, the Dispatch component applies rules to the message. The rules 
determine how the server processes the message. Every message on the server must match a rule associated with 
an action in order to be processed and distributed to its final destination. The additional configuration in this section 
ensures that rules exist for AccuRoute scanning features.

Several AccuRoute scanning features require special rules on the AccuRoute server. Most of these rules are created 
by default when you install AccuRoute v3.01.

You can, also, create rules based on the AccuRoute scanning features available on devices in your environment. For 
more information on rules and how to create them, consult the Omtool Server Administrator Help. 

When rules have been created for all AccuRoute scanning features available on devices in your environment, the 
AccuRoute server is fully configured for Ricoh ESA Device Client. Now you are ready to test the AccuRoute scanning 
features. Go to Section 7: Testing.

Creating a rule for Scan to Folder feature

Note You will need to create this rule only if you are planning to use the Scan to Folder feature.

When a device user selects the Scan to Folder feature, and scans a document, the Ricoh ESA Device Client associates 
the destination e-mail address “FileScan” with the scanned document. This is the unique characteristic you must use 
to create a rule for this feature.

The routing rule you create must route all outbound messages with the destination e-mail address “FileScan” to a 
network folder. Other custom actions can be added to the rule.

Note The Scan to Folder feature requires the Filescan connector. The Filescan connector must be added to the 
AccuRoute server before the rule can be created. For more information on the Filescan connector, 
consult the Administrator help. Go to Related documentation on 1-8.

The device user is able to use the Scan to Folder feature only if you create the following outbound rule in the 
AccuRoute Server:

http://www.omtool.com/documentation/omtoolserver/v37/admin/About_rules.htm
http://www.omtool.com/documentation/omtoolserver/v37/admin/About_rules.htm
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To create a rule for scans using Scan to Folder:

1 Click Start > All Programs > Omtool > AccuRoute Server > AccuRoute Server 
Administrator.

2 In the console tree, expand the AccuRoute Server Administrator.

3 Expand Rules, right-click Outbound and select New > Rule. The Create New Rule wizard appears.

4 Set the criteria for this rule:

a Click Add, select Destination is an e-mail address, and click Next.

b Select is, type FileScan in the text box. Click Add.

c Click Finish. The Create New Rule wizard adds the criteria to the rule.

Note The value FileScan is not case-sensitive.

d Click Next.

5 Create the action for this rule:

a Click Add, select Route to Connector. Click Next.

b Select the Filescan connector in the Route to Connector menu, select a file format for 
delivered messages in the Document Delivery Format menu.

c Go to the override section and check Destination. Enter the location of the destination folder. 

UNC format must be used for any folder that is not on the AccuRoute server. For example:

\\FileServer\ShareA

A relative path to a local drive is valid if the drive is installed on the AccuRoute server. For 
example:

c:\ScanToFolder

d Click Finish. The Create New Rule wizard adds the action to the rule.

This action routes messages to the destination folder in the specified delivery format. Additional 
actions can be added to achieve a custom routing behavior but none are required.

e Click Next.

6 Add a failover action if necessary. Click Next.

The failover action is executed if the primary action fails. For example, the primary action routes 
messages to a destination folder on FileServer A and the secondary action routes messages to a 
destination folder on FileServer B. A routing failure can occur if a network issue prevents 
communication between the AccuRoute server and the file server or if the file server is offline.

7 Verify that Stop processing other rules is selected. Click Finish. 

The new outbound rule appears in the details pane.
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This section includes:

Configuring the auto reset option (6-1)

Configuring the User PIN Identification (6-2)

Configuring User PIN with password (6-3)

Enabling logging (6-4)

Modifying memory sizes of Heap, Stack and System Memory (6-5)

Enabling Job Build (6-5)

Configuring nested buttons (6-6)

Configuring custom button images (6-7)

Configuring prompts (6-7)

Configuring print confirmation (6-10)

Configuring the auto reset option
Device users can scan documents with large number of pages only if the default auto reset time of 30 seconds is 
changed to a higher value. To configure the auto reset option:

1 Navigate to:

C:\Program Files\omtool\Omtool Server\WebAPI\OmtoolWebAPI\Scripts\

2 Open Configuration.Ricoh.xml for editing.

3 Under the <Configurations> node, look for the specific device group or <Default> node for 
the default group. 

4 Locate the <AutomaticLogOut> node and set the time seconds from 30 to 300 or a time that is 
appropriate for your environment. 

5 Save you changes.

6 Restart the World Wide Web Publishing service.

7 Stop and restart the OmtoolXlet application at the device. 
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Configuring the User PIN Identification 
You must configure the Configuration.Ricoh.xml using the instructions below before device users can use 
the User PIN Identification feature. To configure the user PIN identification:

1 Navigate to:

C:\Program Files\omtool\Omtool Server\WebAPI\OmtoolWebAPI\Scripts\

2 Open Configuration.Ricoh.xml for editing.

3 Now go to the <Type> node and change the :value to PIN:

<Type>PIN</Type>

4 If <UseABService="true">, username and password is not required to authenticate against the 
LDAP Server.

If <UseABService="false"> username and password is required to authenticate against the 
LDAP Server. The following example shows how you can provide the username and password. 

<Username>administrator@domain.net</Username> 

<Password>yourpassword@2006</Password> 

Note The username should be a fully qualified domain name. 

5 When validating against Active Directory, if the field is anything other than employeeID (the default), 
add the <Filter> node under <Search UseABService> node. For example:

<Filter>facsimileTelephoneNumber</Filter>

<Attributes></Attributes> 

6 Go to the <User> node under the <Type> node and change the value of the <Label> node to 
PIN:

<Label>PIN:</Label>

7 Save your changes to the file.

8 Restart the World Wide Web Publishing service.

9 Stop and restart the OmtoolXlet application at the device. 

After configuring User PIN in this fashion, login to AccuRoute feature on the device by specifying 
facsimileTelephoneNumber for Usr-1 (set in Active directory) instead of the email address.
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Configuring User PIN with password
By default, the PIN authentication is validated against the employeeID in Active Directory. To configure validation 
against any other Active Directory field other than employeeID, you need to configure the <Filter> node as shown 
in the following procedure.

To configure user PIN with password:

1 Navigate to the directory:

C:\Program Files\omtool\HPOXP\Configuration

2 Open Configuration.Ricoh.xml for editing. 

3 Now go to the <Type> node and change the value of the node to PIN:

<Type>PIN</Type>

4 If <UseABService="true">, username and password is not required to authenticate against the 
LDAP Server.

If <UseABService="false"> username and password is required to authenticate against the 
LDAP Server. The following example shows how you can provide the username and password. 

<Username>administrator@domain.net</Username> 

<Password>yourpassword@2006</Password> 

Note The username should be a fully qualified domain name. 

5 When validating against Active Directory, if the field is anything other than employeeID (the default), 
add the <Filter> node under <Search UseABService> node. For example, 

<Filter>facsimileTelephoneNumber</Filter>

<Attributes></Attributes> 

6 Go to the <User> node and change the value of the <Label> node to PIN:

<Label>PIN:</Label>

7 Go to the <Password> node and change the value of the <Label> node to Password:

<Label>Password:</Label>

8 After you finish making necessary change, save the file.

9 Restart the World Wide Web Publishing service.

10 Stop and restart the OmtoolXlet application at the device. 
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Enabling logging
Device logging

1 Open a command prompt.

2 Run the following command: rsh <IPAddress> mmesg_auto 125

Where IPAddress is the IP address of the device that you are trouble shooting.

Embedded AccuRoute for Intelligent Devices (Omtool ISAPI web server extension) logging

1 Open the Registry Editor.

2 Browse to hkey_local_machine\software\Wow6432Node\Omtool\WEBAPI.

3 Change the DWORD setting for DebugEnabled from 0 to 1.

4 Create a directory under C:\ call it Debug, specify a folder under Debug directory with the same 
name.

5 Stop and start World Wide Web Publishing Service.

This is how the Registry Editor should look:
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Modifying memory sizes of Heap, Stack and System 
Memory

1 Walk up to the Ricoh device and click User Tools > Counters.

2 Select Extended Feature Settings.

3 In the Extended Feature Settings Menu select Extending Feature Setting. 

4 Select the Administrator Tools tab.

5 Select Heap/Stack Size Settings. A dialog open displaying heap, stack and total memory sizes. 

6 Modify the heap and stack sizes or restore them to the default values as needed.

Note System memory sizes cannot be changed.

Enabling Job Build

Note The following configuration should be performed every time a user needs to use set the Job Build mode 
on. 

1 Navigate to:

C:\Program Files\omtool\Omtool Server\WebAPI\OmtoolWebAPI\Scripts\

2 Open Configuration.Ricoh.xml for editing.

3 Locate the <DeviceScanSettings> node and then the <ScanSourceMode> node. 

4 Modify the value for the <ScanSourceMode> node as shown below. 

<ScanSourceMode>SADF</ScanSourceMode>

5 After you finish making the necessary changes, save the file.

6 Restart the World Wide Web Publishing service. 

7 Stop and restart the OmtoolXlet application at the device. 

Now the user will be prompted to add more pages when scanning.
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Configuring nested buttons
By default, Omtool feature buttons are displayed at the top level of the control panel of a device. You can, if needed, 
configure the top level button to be a group button under which there can be multiple buttons. For example, the top 
level button could be AccuRoute under which feature buttons like MyAccuRoute, Scan to Folder etc. can be nested 
together. Depending on the need, you can configure multiple levels which means that a group button can have 
another group button containing a group of feature buttons.

Nesting or collapsible buttons can have their custom images specified in the configuration xml file. For instructions, 
see Configuring custom button images.

To configure nested buttons:

1 Navigate to:

C:\Program Files\omtool\Omtool Server\WebAPI\OmtoolWebAPI\Scripts\

2 Open Configuration.Ricoh.xml for editing.

3 Configure the nested button using the following below:

 Set the Feature attribute type to "Button". 

 Next configure the <FeatureSpecific> node to contain a list of the Feature id's that will be 
grouped within the button. 

Here is an example of how to configure nested buttons. In this example, the top level button is 
AccuRoute and the Fax, SubAccuRoute and MyAccuRoute buttons are grouped within the top level 
AccuRoute button. 

<Feature id="AccuRoute" type="Button" enabled="true" toplevel="true">

<Image></Image>

<Text>AccuRoute</Text>

<Description>This is an AccuRoute button</Description>        
<AllowUseByNonAuthenticatedUsers>true</
AllowUseByNonAuthenticatedUsers>

<FeatureSpecific>

<Fax/> <!- Feature id for Fax feature ->

<SubAccuRoute/> <!- Feature id for SubAccuRoute feature ->

<MyAccuRoute/> <!- Feature id for MyAccuRoute feature ->

</FeatureSpecific>

</Feature>

4 After you finish making necessary change, save the file.

5 Restart the World Wide Web Publishing service. 

6 Stop and restart the OmtoolXlet application at the device. 



© 2013 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

6-7Ricoh Embedded Software Architecture (ESA) Device Client v1.4 Installation and Integration Guide

Section 6: Optional configuration

Configuring custom button images
You can configure custom button images for dynamic retrieval via a URL. These custom button images should all be 
stored in the \Scripts directory in order for them to be dynamically retrieved.

Note If custom images are not configured, the device displays the default AccuRoute button images. Current 
AccuRoute images are 92 pixels high and 62 pixels wide. 

To configure custom button images:

1 Copy the custom images from a network folder, then go to the directory:

C:\Program Files\omtool\Omtool Server\WebAPI\OmtoolWebAPI\Scripts\

Paste in the images.

2 Define relative path to the images in the Configuration.Ricoh.xmlfile.

3 For example, to define a custom Public Distributions image, you will need to copy the custom image to 
the \Scripts directory. Then open the Configuration.Ricoh.xmlfile and define the relative 
path as /Ricoh/Public.bmp. Now the image will be retrieved from the following location:

http://<Servername>/OmtoolWEBAPI/scripts/Ricoh/Public.bmp

4 After you finish making necessary change, save the file.

5 Restart the World Wide Web Publishing service.

6 Stop and restart the OmtoolXlet application at the device. 

Configuring prompts
You can configure prompts for Personal and Public Distributions, Routing Sheet, Fax, Scan to Folder and 
MyAccuRoute features using the Configuration.Ricoh.xml file. For the Public and Personal Distributions features, 
prompts can be configured in the xml file or on the AccuRoute server. The prompts that are configured on the server 
are also known as Embedded Directive Prompts. For more information, see Embedded Directive Prompts. 

Ricoh Embedded Software Architectures (ESA) Device Client supports user specified values for the following 
properties:

 File Name

 File Type

To configure prompts:

1 Navigate to:

C:\Program Files\omtool\Omtool Server\WebAPI\OmtoolWebAPI\Scripts\

2 Open Configuration.Ricoh.xml for editing.

http://www.omtool.com/documentation/omtoolserver/v36/admin/About_Embedded_Directive_prompts.htm
http://www.omtool.com/documentation/omtoolserver/v36/admin/About_Embedded_Directive_prompts.htm
http://www.omtool.com/documentation/omtoolserver/v36/admin/About_Embedded_Directive_prompts.htm
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3 Add a new <Prompts> node under the <Omtool> node.

4 Enter the following code using the following example as a guideline. In this example, the 
DMSDocumentName prompt is being set up.

<Prompts>

<DMSDocumentName>

<Display>Wizard</Display> 

<Label>DMS Document Name:</Label> 

<Type MinLength="5" MaxLength="15">Text</Type>

<Instructions>Enter the dms document name</Instructions>

<Values>

<Value internal="" default="true">dmsdocument</Value>

</Values>

<Properties>

<Property override="true">prDMSDocName</Property> 

</Properties>

</DMSDocumentName>

</Prompts>

5 Search for the AccuRoute feature that should use this prompt. Only the Routing Sheet, Fax and 
MyAccuRoute features can use prompts configured in the xml file.

There is a </Prompts> placeholder. You can either overwrite it or add a new <Prompts> node. 

6 Go to the <Prompts> node under the feature node.

7 Enter the following code:

<Prompts>

<Prompt>DMSDocumentName</Prompt> 

</Prompts>

8 After you finish making necessary change, save the file.

9 Restart the World Wide Web Publishing service.

10 Stop and restart the OmtoolXlet application at the device. 
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Now when a user goes to the device and scans a document using the AccuRoute feature for which the prompt was 
configured, a Wizard opens asking for the DMS Document Name. 

Table 6-1: Guidelines on creating prompts

Property Impact Syntax

Prompt Name Determines the value of the prompt string 

Display Determines whether the overriding property would be displayed in a separate Wiz-
ard page.

Use the following value:

Wizard

Label Determines the title to be displayed for Wizard screen. [Name of the label]

Instructions Determines the instructions that are displayed on the Wizard screen [description]

Type Determines the data type of the prompts.

The attributes MinLength and MaxLength determine the minimum and maximum 
text data entry length respectively. If the default text value in the Configura-
tion.Ricoh.xml file exceeds the MaxLength, then it chops off the length before dis-
playing it.

Note: These attributes are not applicable for GenericList data type.

Use one of the following values:
• Text
• GenericList

Value Determines the value to be displayed or selected on the Wizard screen based on the 
data type.

[Value]

The attribute internal stores the corresponding internal code used within the 
Accuroute server. 

[code value]

The attribute default denotes that the corresponding value is the default. For 
GenericList data type, the value is selected by default on the screen. For Text data 
type, the corresponding value is displayed in the text box.

Use one of the following values:
• true
• false

Property Determines the property name that is used within the Accuroute server. [Property name]

The override attribute denotes that this is an overriding property. User one of the following values:
• true
• false
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Configuring print confirmation

Note Print confirmation requires that the Ricoh device supports PDF printing.

1 Navigate to:

C:\Program Files\omtool\Omtool Server\WebAPI\OmtoolWebAPI\Scripts\

2 Open Configuration.Ricoh.xml for editing.

3 Locate the <PrintConfirmation> node under each AccuRoute feature.

4 Modify the node as follows:

<PrintConfirmation>

          <Enabled>true</Enabled>

          <Template>PrintConfirmation</Template>

          <Name></Name>

          <Class>PrintConfirmationPDF</Class>

</PrintConfirmation>

Where:

 the default value of <Enabled> is false.

 <Template> node is required for PDF printing only.

 <Name> is the label for Print button. If empty, it is called "Print Status".

 <Class> denotes text or PDF printing. The value PrintConfirmationText denotes text 
printing and PrintConfrmationPDF denotes PDF printing.

5 After you finish making necessary change, save the file.

6 Restart the World Wide Web Publishing service.

7 Stop and restart the OmtoolXlet application at the device. 
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Section 7: Testing

This section includes:

Testing the Routing Sheet feature (7-1)

Testing the Fax feature (7-5)

Testing the Personal Distributions feature (7-10)

Testing the Public Distributions feature (7-14)

Testing the Scan to Folder feature (7-18)

Testing the My AccuRoute feature (7-21)

Testing the Routing Sheet feature
1 Create at least one Embedded Directive with your user account. 

Note Applications that can create Embedded Directives include AccuRoute Desktop and the AccuRoute Web 
Client.

2 Generate and print a Routing Sheet using AccuRoute Desktop or the AccuRoute Web Client.

3 Assemble a test document and add the Routing Sheet to the front of the document. Then go to the 
device. The main screen looks like this:
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4 Press Routing Sheet. 

5 Load your document. 

 To use the automatic document feeder, load the document into the automatic document 
feeder. 

 To use the exposure glass, lift the cover, place an original on the exposure glass, close the 
cover.

6 Press Start on the hard keypad.
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7 The device scans the document. If the job build mode is on (ScanSourceMode is set to SADF in the 
configuration file or in the Settings screen), you will see the following message. 

Note Depending on your device configuration, the screens you see after scan is complete may be different.

8 To scan additional pages, load the pages and press Start.
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9 When scanning is complete, press # on the keypad. The device initiates a routing request and shows 
the following message.

10 Press OK to go back to the main AccuRoute page. 

11 Wait a few minutes and check the recipient address or destination to confirm delivery. 

If the document does not arrive at the recipient address or destination, troubleshoot the setup. Go to 
Section 8: Troubleshooting.
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Testing the Fax feature
1 Choose a working fax number for the test fax.

2 Assemble a test document and go to the device. The main AccuRoute screen looks like this:

3 Press Fax. The display panel shows options for the fax. 
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4 Enter the fax number following the instructions below. 

a Press the keyboard beside the Fax number text box. 

b Optionally use the hard keypad to enter the fax number. 

5 To include a cover page, press Yes under Add Cover Page. 

a To enter the name of the sender, press the keyboard option beside the Sender Name text 
box. Use the keypad that opens to enter the name. 

b To enter the name of the recipient, press the keyboard option beside the Recipient Name 
text box. Use the keypad that opens to enter the name. 

c To enter a subject, press the keyboard option beside the Subject text box. Use the keypad that 
opens to enter the subject. 
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The Omtool Xlet uses the template “OmtoolCoverPage” when a cover page is requested. A template 
with this filename must exist on the AccuRoute server in 
…\Omtool\OmtoolServer\Languages\XXX\Templates. For more information, consult the 
Omtool Server Administrator help. (Go to Related documentation on 1-8.)

6 Press Next. The summary page opens. 

7 Load your document. 

 To use the automatic document feeder, load the document into the automatic document 
feeder. 

 To use the exposure glass, lift the cover, place an original on the exposure glass, close the 
cover.

8 Press Start. 
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The device scans the document. If the job build mode is on (that is the ScanSourceMode is set to 
SADF in the configuration file or in the Settings screen), you will see the following message. 

Note Depending on your device configuration, the screens you see after scan is complete may be different.

9 To scan additional pages, load the pages and press Start. 
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10 When scanning is complete, press # on the keypad. The device initiates a routing request and shows 
the following message.

11 Press OK to go back to the main AccuRoute page. 

12 Wait a few minutes and check the recipient address or destination to confirm delivery. 

If the document does not arrive at the recipient address or destination, troubleshoot the setup. Go to 
Section 8: Troubleshooting.
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Testing the Personal Distributions feature
1 Create at least one Embedded Directive with your user account. 

Note Applications that can create Embedded Directives include AccuRoute Desktop and the AccuRoute Web 
Client.

2 Assemble a test document and go to the device.The main AccuRoute screen looks like this:

3 Press Personal Distributions. The device prompts you to log in.
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If you are configured to use non authenticated email for example, you will see the following page. 

4 Log in using the credentials you used to create the Embedded Directive by following the steps below:

a For Domain text box, verify the correct domain name is filled in automatically. If not, modify it by 
pressing keyboard and using the electronic keyboard that opens.

b For the Email text box, press keyboard and entering your email address using the electronic 
keyboard that opens.

c Press OK.

The device shows your personal distribution options.



Ricoh Embedded Software Architecture (ESA) Device Client v1.4 Installation and Integration Guide

Section 7: Testing

© 2013 by Omtool, Ltd. All rights reserved. Omtool, AccuRoute and the Company logo are trademarks of the Company. Trade names and trademarks of other companies appearing in this document are the property of their respective owners.

7-12

5 Select a personal distribution. The display panel shows a summary of this document distribution 
option.

6 Load the document:

 To use the automatic document feeder: Load the document into the automatic document 
feeder. 

 To use the exposure glass: Lift the cover, place an original on the exposure glass, close the cover.

7 Press Start. 
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The device scans the document. If the job build mode is on (that is the ScanSourceMode is set to 
SADF in the configuration file or in the Settings screen), you will see the following message. 

Note Depending on your device configuration, the screens you see after scan is complete may be different.

8 To scan additional pages, load the pages and press Start. 

9 When scanning is complete, press # on the keypad. The device initiates a routing request and shows 
the following message.
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10 Press OK to go back to the main AccuRoute page. 

11 Wait a few minutes and check the recipient address or destination to confirm delivery. 

12 If the document does not arrive at the recipient address or destination, troubleshoot the setup. Go to 
Section 8: Troubleshooting.

Testing the Public Distributions feature
1 Create at least one Embedded Directive with the user account that is associated with the Public 

Distributions feature. The Embedded Directive must allow multiple use. 

Note Applications that can create Embedded Directives include AccuRoute Desktop and the AccuRoute Web 
Client.

2 Assemble a test document and go to the device. The main AccuRoute screen looks like this. 

3 Press Public Distributions. 
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The device shows the public distribution options.

4 Select a public distribution option. The display panel shows a summary of this document distribution 
option. 

5 Load your document. 

 To use the automatic document feeder, load the document into the automatic document 
feeder. 
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 To use the exposure glass, lift the cover, place an original on the exposure glass, close the 
cover.

6 Press Start. 

7 The device scans the document. If the job build mode is on (that is the ScanSourceMode is set to 
SADF in the configuration file or in the Settings screen), you will see the following message. 

Note Depending on your device configuration, the screens you see after scan is complete may be different.

8 To scan additional pages, load the pages and press Start.
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9 When scanning is complete, press # on the keypad. The device initiates a routing request and shows 
the following message. 

10 Press OK to go back to the main AccuRoute page. 

11 Wait a few minutes and check the recipient address or destination to confirm delivery. 

If the document does not arrive at the recipient address or destination, troubleshoot the setup. Go to 
Section 8: Troubleshooting.
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Testing the Scan to Folder feature
1 Assemble a test document. Then go to the device. The main screen looks like this:

2 Press Scan to Folder. 

3 Load your document. 

 To use the automatic document feeder: Load the document into the automatic document 
feeder. 
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 To use the exposure glass: Lift the cover, place an original on the exposure glass, close the 
cover.

4 Press Start on the hard keypad.

5 The device scans the document. If the job build mode is on (that is the ScanSourceMode is set to 
SADF in the configuration file or in the Settings screen), you will see the following message. 

Note Depending on your device configuration, the screens you see after scan is complete may be different.

6 To scan additional pages, load the pages and press Start.
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7 When scanning is complete, press # on the keypad. The device initiates a routing request and shows 
the following message.

8 Press OK to go back to the main AccuRoute page. 

9 Wait a few minutes and check the recipient address or destination to confirm delivery. 

If the document does not arrive at the recipient address or destination, troubleshoot the setup. Go to 
Section 8: Troubleshooting.
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Testing the My AccuRoute feature
1 Verify that MyAccuRoute has been configured for your user account. For more information, consult 

the AccuRoute Desktop installation guide and AccuRoute Desktop user guide. Go to Related 
documentation on 1-8.

2 Assemble a test document and go to the device. The main AccuRoute screen looks like this:

3 Press MyAccuRoute. The device prompts you to log in. 

If you are configured to use non authenticated email, for example, you will see the following page. 
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4 Log in with using the account credentials you used to create the Embedded Directive by following the 
steps below:

a For Domain text box, verify the correct domain name is filled in automatically. If not, modify it by 
pressing keyboard and using the electronic keyboard that opens.

b For the Email text box, press keyboard and entering your email address using the electronic 
keyboard that opens.

c Press OK.

You see the summary page.

5 Load the document:

 To use the automatic document feeder: Load the document into the automatic document 
feeder. 

 To use the exposure glass: Lift the cover, place an original on the exposure glass, close the 
cover.
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6 Press Start. 

The device scans the document. If the job build mode is on (that is the ScanSourceMode is set to 
SADF in the configuration file or in the Settings screen), you will see the following message. 

Note Depending on your device configuration, the screens you see after scan is complete may be different.

7 To scan additional pages, load the pages and press Start.
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8 When scanning is complete, press # on the keypad. The device initiates a routing request and shows 
the following message.

9 Press OK to go back to the main AccuRoute page. 

10 Wait a few minutes and check the recipient address or destination to confirm delivery. 

If the document does not arrive at the recipient address or destination, troubleshoot the setup. Go to 
Section 8: Troubleshooting.
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Section 8: Troubleshooting

This section includes:

Detecting workflow issues (8-1)

Troubleshooting the delivery mechanism (8-2)

Troubleshooting the message on the AccuRoute server (8-2)

Troubleshooting the multifunction device (8-4)

Complete these procedures in the order they appear. If you cannot resolve the issue, contact Omtool. (Go to 
Omtool support and sales on the inside front cover.)

Detecting workflow issues
After a document has been scanned on the device, the document should arrive at its destination momentarily but 
can take up to several minutes when the server workload is high. If a document does not arrive at its destination 
within a reasonable period of time, begin troubleshooting the environment. Omtool recommends troubleshooting 
the workflow in reverse order because this is the easiest way to troubleshoot the setup on your own.

The easiest way to troubleshoot a workflow issue is to follow the document through the workflow in reverse order. When a 
document does not arrive at its destination, troubleshooting starts with the delivery mechanism such as the mail server or DMS 
application, and then continues to the AccuRoute server, the web server, and the device.

Figure 8-1: Troubleshooting the workflow in reverse order

To begin troubleshooting, go to Troubleshooting the delivery mechanism (8-2).
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Troubleshooting the delivery mechanism
When the AccuRoute server finishes processing a message, an outbound connector routes the message directly to 
its destination or passes the message onto a delivery agent. If a delivery agent such as a mail server or DMS application 
is involved in the delivery process, do some basic troubleshooting on the delivery agent. If the delivery agent is 
functioning correctly, troubleshoot the message on the AccuRoute server. Continue to Troubleshooting the message 
on the AccuRoute server.

Troubleshooting the message on the AccuRoute server
There are two important questions that can be resolved when troubleshooting a message on the AccuRoute server:

 Was the message submitted to the AccuRoute server?

 Assuming the message was submitted to the AccuRoute server, what caused the delivery failure? The 
state and status of the message, along with details in the message journal, provide important clues.

Start troubleshooting by trying to locate the message on the AccuRoute server:

1 Click Start > All Programs > Omtool > AccuRoute Server > AccuRoute Server 
Administrator.

2 In the console tree, expand the AccuRoute Server Administrator and go to [ServerName] > 
Messages.

3 Look for the message in the In Process queue:

a Click In Process.

b View All Items.

c Sort all items by the date submitted.

d Look for the message.

 Message found - View the message journal to determine the current state and status of the 
message. Then monitor the components and confirm that the message is moving through the 
processing queues on the AccuRoute server. If the AccuRoute server stops processing the 
message (for example, the message seems to be stuck in a processing queue), restart all 
Omtool services.

 Message not found - Go to step 4 and look for the message in the History queue.
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4 Look for the message in the History queue:

a Click History.

b View All Items.

c Sort all items by the date submitted.

d Look for the message.

 Message found - View the message journal to determine the cause of the failure.

If the message failed, correct the issue and send the message again. Contact Omtool if you are 
unable to resolve the issue. (Go to Omtool support and sales on the inside front cover.)

If the journal states that AccuRoute server delivered the message but it still has not arrived at 
its destination, this indicates that the AccuRoute server transferred the message to the 
delivery agent successfully. Do some advanced troubleshooting on the delivery agent to 
determine why the message is not being delivered to its destination. Contact Omtool if you 
are unable to resolve the issue. (Go to Omtool support and sales on the inside front cover.)

 Message not found - Continue to Troubleshooting the web server.

Troubleshooting the web server
The Embedded AccuRoute for Intelligent Devices installation guide has instructions on troubleshooting the web 
server. (Go to Related documentation on 1-8.)

If you cannot identify any issues with the web server, troubleshoot the device. Continue to Troubleshooting the 
multifunction device.
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Troubleshooting the multifunction device
After troubleshooting all other components in the workflow, troubleshoot the device using the information in the 
following table.

Table 8-1: Common methods of troubleshooting the multifunction device

Issue Resolution

The Omtool Xlet is stopped. Start the Omtool Xlet using the Application Manager.

The device is not working properly for reasons unrelated to the 
Omtool Xlet.

Consult the documentation on the device for troubleshooting 
information.
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Appendix A: Setting up HTTPS with 
Windows 2008 

This section includes:

Installing Embedded AccuRoute for Ricoh ESA (A-1)

Creating a self-signed certificate (A-2)

Creating an SSL binding (A-3)

Verifying the SSL binding (A-4)

Exporting and saving the certificate (A-4)

Adding the certificate to the Ricoh ESA Device Client (A-4)

Important When creating a Self Signed Certificate it automatically uses the fully qualified domain 
name as the "Issued to" and "Issued by" address. Therefore all addresses that are used 
when configuring https with a self cert must use the fully qualified domain name.

Installing Embedded AccuRoute for Ricoh ESA
1 Navigate to the following directory for the setup files.:

C:\Program Files (x86)\omtool\Omtool Server\Clients\Ricoh

For installation instructions, see Installing Ricoh ESA Device Client v1.4 (3-4).

Note During installation, use the fully qualified domain name for both AccuRoute Server as well as the 
Authentication server as shown below.
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Creating a self-signed certificate
1 Open Internet Information Services Manager.

2 Click on the local machine and double click Server Certificates option under IIS to open the 
Server Certificates dialog.
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3 Right click on the Server Certificates dialog and choose Create Self Signed Certificate from the 
drop down menu options. 

4 In the Specify Friendly Name page that opens, go to the Specify a friendly name for the 
certificate text box and enter an appropriate name. 

Note The friendly name must match the name of your system. The self signed certificate will be created based 
on the fully qualified domain name.

Creating an SSL binding
1 Open Internet Information Services Manager.

2 Click on the Default website and locate Bindings under Edit Site (top right hand corner of 
window)

3 Click on Bindings. The Site Bindings dialog opens. 

4 Click on type HTTPS and choose Edit. The Edit Site Bindings dialog opens. 

5 In the SSL certificate drop-down choose the certificate that was created earlier and click OK. 

6 Click Close.
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Verifying the SSL binding
1 In Internet Information Services Manager, expand the tree view and select OmtoolWebAPI.

2 Click on Browse *:443 (https) under Manage Application/Browse Application (located on top 
right hand corner of the IIS dialog).

3 A message stating There is a problem with this website's security 
certificate opens. This is expected and you should continue configuring. 

4 Click Continue to this website option. 

5 Verify that IIS 7 dialog opens. 

Exporting and saving the certificate
1 In the Server Certificate dialog right click on the certificate and choose View.

2 In the Certificate dialog choose the Details tab and choose Copy to File. The Certificate 
Export Wizard opens.

3 Click Next.

4 In the Private Key Dialog select No, do not export the private key, click Next.

5 In the File Formats dialog choose Base-64 encoded X.509 (.CER), click Next.

6 In the Filename dialog browse to a location to save the .cer file and give it a filename, select Save 
and then Next.

7 Verify the settings and choose finish. The export is complete.

Adding the certificate to the Ricoh ESA Device Client
1 Navigate to:

C:\Program Files (x86)\omtool\ISAPIClients\Ricoh\XletRepository

2 Using WinZip, open the 33960102.zip file. 

3 Extract the cacerts.jar file on to your local system.

4 Using WinZip, open the cacerts.jar file.

5 Locate the jdk-certs file within the cacert.jar file and extract it to your local system.

6 Create a folder at the root of C:\ (for example, C:\certs)

7 Place the certificate file and the jdk-cacerts file within the newly created folder
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8 Using the Keytool:

a Install the Java environment on the system.

b Add the following paths to the Path Variable of the systems Environmental Variables:

C:\Program Files (x86)\Java\j2re1.4.2_19\bin;C:\Program Files 
(x86)\Java\j2re1.4.2_19\lib; C:\Program Files 
(x86)\Java\j2re1.4.2_19\bin;

c Open the command prompt and change the directory to the newly created folder (for example, 
C:\certs).

d Run the following command:

keytool -keystore jdk-cacerts -storepass changeit -import -alias 
<commonname> -file <certificatename> -trustcacerts 

where <commonname> can be anything and <certificatename> matches the name of the 
certificate. 

a Choose Yes to import the certificate. 

9 Add the jdk-cacerts back into cacerts.jar following the instructions below:

a Open cacerts.jar using WinZip.

b Delete the jdk-cacerts file located within cacerts.jar.

c Right click on jdk-cacerts and choose WinZip>Add to Zip File.  

d Add the file to the cascerts.jar file.

e In the cacerts.jar file, verify that the jdk-cacerts file has the proper date and time 
stamp.

f Open the 33960192.zip file and delete the cacerts.jar file.

g Right click on cacerts.jar and choose WinZip >Add to Zip File.

h In the Add to Archive section select Open and browse to:

C:\Program Files (x86)\omtool\ISAPIClients\Ricoh\XletRepository\
33960192

i Select Open.

j Verify that the path is correct and select Add.

k In the 33960192.zip file, verify that the cacerts.jar file has the proper date and time stamp.

10 Verify the fully qualified domain name is correct in OmtoolXlet.dalp following the instructions below:

a Open the 33960192.zip file, locate OmtooXlet.dalp and extract it.

b Open the extracted OmtoolXlet.dalp file.

c Change -servername from an IP address to a fully qualified domain: For example: 
<argument>-servername:100.00.00.000</argument>

d Add the OmtooXlet.dalp back into the 33960192.zip file.

11 Enable the Require SSL option for the WebSite following the instructions below:

a Open Internet Information Services Manager.

b Expand \local machine\Default WebSite and choose OmtoolWebAPI.
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c Open SSL Settings and check the Require SLL option. 

d Under client certificates choose Ignore.

12 Change the DNS settings on the device following the instructions below:

13 On the Ricoh device change the following settings under User Tools\System Settings\Interface 
Settings.

14 Select DNS configuration and enter the DNS IP address.

15 Select Domain Name and enter the fully qualified domain name for the DNS server.

16 Lastly, push the Ricoh Embedded Software Architecture (ESA) Device Client to the Ricoh device using 
the AccuRoute Server Administrator.

Important If Ricoh Embedded Software Architecture (ESA) Device Client is already installed on the 
device, it must be uninstalled and then reinstalled to for the changes to be reflected.
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Appendix B: Configuring with AccuRoute 
Server v4.0

Configuring Ricoh ESA Device Client for AccuRoute Server v4.0:

1 Run the Ricoh Server Update for Ricoh v1.4 on the AccuRoute Server v4.0.

2 Go to the Ricoh Clients directory:

C:\Program Files (x86)\Omtool\Omtool Server\Clients\Ricoh\

3 Run setup.exe. Fill out all information for the client and complete the installation.

4 Once the installation is complete go to:

C:\Program Files (x86)\Omtool\Omtool 
Server\WebAPI\WebAPI\Scripts\Scripts

Move the Configuration.Ricoh.xml file to the previous scripts directory:

C:\Program Files (x86)\Omtool\Omtool Server\WebAPI\WebAPI\Scripts\

5 Open the Configuration.Ricoh.xml file and make the following changes:

a Change the URL of the ServiceURL node from:

<ServiceURL>http://[AccuRoute_server_ip_address]/OmtoolWEBAPI/
scripts/OmISAPIU.dll</ServiceURL>

to:

<ServiceURL>http://[AccuRoute_server_ip_address]/WEBAPI/scripts/
OmISAPIU.dll
</ServiceURL>

b Change the URL of the FileTransferURL from:

<FileTransferURL>http://[AccuRoute_server_ip_address]/
OmtoolWEBAPI/FileTransfer/
</FileTransferURL>

to:

<FileTransferURL>http://[AccuRoute_server_ip_address]/WEBAPI/
FileTransfer/
</FileTransferURL>

c Save the changes to the Configuration.Ricoh.xml file.

6 Make changes to the OmtoolXlet.dalp file:

a Unzip the 33960192.zip file located in:

C:\Program Files (x86)\Omtool\ISAPIClients\Ricoh\XletRepository

b In WinZip, locate the OmtoolXlet.dalp file within the Zip file and extract it to a location (this 
can be the desktop or any other folder).
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c Open the OmtoolXlet.dalp file using Notepad and make the following changes:

 Service Path - Change the service path section to point to the proper directory and DLL. 
Change to:

<argument>-servicepath:/WebAPI/scripts/omisapiu.dll</argument>

 Display Mode - Change the display mode to whatever display mode is supported by the 
device. For example:

<display-mode size="WVGA" />

 Group Name - A group name in Ricoh ESA v1.4 is referred to as a SourceName. In the 
following, Ricoh is the group name created in Admin:

<argument>-sourcename:Ricoh</argument>

d Save the OmtoolXlet.dalp file once the changes are made.

e Add the OmtoolXlet.dalp file back to the 33960192.zip file.

7 Install Ricoh 1.4 to the device using the Embedded Web Server of the Device or using an SD card 
(refer to the Ricoh documentation for details).

8 Once the application is installed on the device start the application in the Extended Features Settings 
of the device.
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